FAAST LT-200

FIRE ALARM ASPIRATION SENSING TECHNOLOGY®

ADVANCED SET-UP AND CONTROL GUIDE
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INTRODUCTION

THE FAAST LT-200 FUNCTIONAL STATE DIAGRAM

The FAAST LT-200 aspirating smoke detector is an advanced
smoke sensing system for use in early warning and very early
warning applications. The system continuously draws air from
the controlled environment through a series of sampling holes to
monitor the environment for smoke particulate. A range of sensing,
operating and output facilities can be configured in the FAAST LT200 unit by the end user. This is accomplished by programming
and downloading control parameters from a PC running the
proprietary software application, PipeIQ™. Note: Always check
you are using the latest version of PipeIQ™. (See Appendix D for
PipeIQ™ download and set-up details.)

In operation, the device can be in one of 6 possible states:
Initialization
Normal
Maintenance
Remote Maintenance
Service Mode
Power Out Of Range state
The routes in and out of these states are shown in the diagram
below.

Power in Correct Range
Maintenance Timeout or after TEST + RESET + DISABLE (When Device Configuration has been Changed)

(Power-ON)

INITIALIZATION

RESET + Password Enter (During Auto Speed Procedure)
Maintenance Timeout or after
TEST + RESET + DISABLE
(No Need for Device to Initialize)

NORMAL
RESET +
DISABLE
Cover
Close

SERVICE
MODE
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MAINTENANCE

Power < 18V
Power > 32V

RESET +
Password Enter
Cover Open +
USB
Connected

Cover
Open
DISPLAY
FAN
SPEED

USB
Disconnected
+ Cover Close

REMOTE
MAINTENANCE
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POWER OUT OF
RANGE STATE
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Power-On/Initialisation
A FAAST LT-200 device always powers on in the Initialisation state
where internal checks are completed and the air flow/fan speed is set
before entering the Normal state.

the FAULT indicator flashes yellow and the unit remains in Normal
mode. The Default password in 3111.
If no button is pressed for 10s during the password sequence, the
unit returns to Normal mode. If there is no activity in Maintenance
mode for 5 minutes (default), the fault indicator blinks green for 15s
and then the unit returns to the Normal state.

Normal
In the Normal state the FAAST LT-200 operates as a smoke
detector. The main button actions are not active, apart from the
combination Reset + Disable which shows the fan speed number,
and the Reset button itself providing access to the Password
Procedure to go to the Maintenance state.

When the USB cable is plugged into the unit, it switches to Remote
Maintenance mode; the maintenance time-out is disabled.
AN INTRODUCTION TO PIPEIQ™
Overview
The PipeIQ™ software program is a convenient and powerful
Windows® based application that can be used to set-up and
monitor the performance of FAAST LT-200 Aspiration devices via a
graphical user interface on a PC (Always check you are using the
latest version of PipeIQ™).

Note: For the loop based FAAST LT-200 device, the module
address will only respond to a panel poll when in Normal mode.
Maintenance
When the correct password is entered, a FAAST LT-200 device will
enter the Maintenance state (See Password Procedure for more
information). The front panel buttons are enabled for maintenance
functions and the FAAST LT-200 unit can be linked to a PC. (See
Remote Maintenance state).

PipeIQ™ also provides facilities to develop and verify the
performance of pipe network solutions, configure the design
parameters to suit local fire codes and standards and generate
pipe layout diagrams, BoMs, parameter tables and event log
reports.

A FAAST LT-200 device will automatically time-out of the
Maintenance state after a preset period of inactivity (Default is 5
minutes).

With a detailed Help Menu to guide the user through the different
screens and options, PipeIQ™ is a comprehensive package
to support the use of the FAAST LT-200 detector in aspirating
applications.

Remote Maintenance
The USB connection can only be used when the FAAST LT-200
device is in the Remote Maintenance mode. To enter the Remote
Maintenance mode, first put the device into Maintenance mode,
open the hinged front cover and connect to a PC with a USB cable
(within 5 minutes). In Remote Maintenance mode it is possible to
control, monitor and re-programme the FAAST LT-200 device via
the PC using PipeIQ™.

Information on downloading and installing the latest versions of
PipeIQ™ can be found in Appendix D of this manual.
The PipeIQ™ User Interface
The graphical user interface for PipeIQ™ includes a title bar, menu
bar, toolbar, left pane, right pane, and status bar as described in
the following table:

The Remote Maintenance mode does not have a time-out. The
FAAST LT-200 device will return to Maintenance mode when the
USB cable is unplugged and the door is firmly shut. (Note: if the door
is not shut within 5 minutes of removing the USB cable, the unit will
enter Service mode.).

Option
Menu bar

Service Mode
When the FAAST LT-200 device is in Normal, the Service Mode
state is entered automatically when the front cover is opened.
The FAAST LT-200 unit switches off the power to the unit. Once
the service action is complete, and the front cover is closed, the
FAAST LT-200 device restarts automatically. Note that when
leaving Service Mode, a unit will always run the initialise routine,
re-calibrating the air flow settings.

Toolbar
Left pane
Right pane
Status Bar

Power Out Of Range State
If the PSU voltage is out-of-range, the FAAST LT-200 unit will stop
working, switching off the power to the unit and signalling a power
fault and a general fault.

Designing detailed pipe networks using PipeIQ™ is beyond the scope
of this manual. For advice on a design approach, see Appendix E.
USING PipeIQ™ TO CONTROL OR MONITOR FAAST LT-200
FAAST LT-200 USB Connection
PC connectivity is provided by an on board USB B socket located
in the middle of the FAAST LT-200 unit behind the hinged front
cover. The USB interface allows access to a range of additional
options via PipeIQ™.

The FAAST LT-200 device remains in this state until it is re-powered
or restarts automatically when the supply voltage returns to within
the correct range.
PASSWORD PROCEDURE (To enter Maintenance Mode)
Press and hold RESET; left hand flow indicator will turn yellow
then green.

Note: To connect, access or change any FAAST LT-200
configuration parameters, the device must be in Maintenance
mode (See Password Procedure to enter Maintenance mode).

Release RESET and FAULT indicator will switch on green. The left
hand flow indicator will blink green indicating the device is ready
for the first digit.

Connecting a PC to a FAAST LT-200 Device for the First Time
Minimum System Requirements
Microsoft Windows Vista, 7, 8 or 10, XP - SP3 (not recommended).

Press DISABLE to increment the LEDs 1…9; press TEST (tick
button) to select a digit.

1 GB of RAM.

The flashing airflow segment will turn solid green and the next
segment will begin to flash indicating set the next digit. When the
4th digit is selected, all 4 airflow segments are turned off. If the
password is accepted the FAULT indicator will remain green and
the unit enters Maintenance mode. If the password is incorrect
D200-100-01

Action
Contains six menus that perform various
tasks such as open, close, save, change
the view, etc
Contains buttons to create, open or save
projects
Displays all the project elements in a tree
structure
Displays detailed information of the item
selected in the left pane
Displays the type of operation (on tabs at the
bottom of the Left Pane)
Tabs: Configuration; Pipe Design; Monitoring

Graphics hardware with 128 MB of memory and support for
OpenGL 2.0 or later.
5 GB of free hard disc space
2
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Air Flow Settings
The FAAST LT-200 operating settings can only be changed using
the PipeIQ™ application. Pipe layouts should be verified for
EN54:20 compliance by running a PipeIQ™ simulation project (via
the Pipe Design tab) and evaluating the results against the strict
approval criteria in the program. Sensitivities, air flow rates and
limits etc are adjusted and optimised within PipeIQ™; the FAAST
LT-200 parameter values are created in the pipe design project
and stored in an associated configuration file. The resulting air flow
rate should be set as the reference flow into the configuration by
pressing the Apply to Configuration button in the PipeIQ™ Pipe
Design mode, which will automatically set the new airflow limits.

The USB driver will be installed automatically during the PipeIQ™
installation procedure. This should NOT be declined during the
installation process.
Note: It is strongly recommended that some form of training
is taken before using any version of PipeIQ™ (contact your
distributor for information on this). The information provided in
this manual is only a short overview.
Preparing to Configure or Monitor a FAAST LT-200 Device
To connect and communicate with a FAAST LT-200 device via the
PC USB port, PipeIQ™ must be running a project (.mdf file) that
matches the type of FAAST LT-200 device being used. If no project
exists on the PC, one will have to be created prior to connecting
(See Creating a Project section).

Modifying the reference flow arbitrarily from within the Configuration
screen is not recommended. Changing the fan speed using the
manual mode from within the Configuration screen should be
avoided. These change options are available primarily for test
purposes only. Manually setting the fan speed to change the air
flow will not alter the associated hi/lo flow limit settings in the
FAAST LT-200 unit. Therefore this option should not be used to set
or change air flow values in an EN54 compliant pipe system; the
PipeIQ™ Pipe Design facility should always be used.

To communicate with a FAAST LT-200 Device.
Ensure that the FAAST LT-200 unit is in Maintenance mode,
PipeIQ™ is running on the PC, then open the front door and
connect a USB cable from the internal socket to the PC.
In PipeIQ™, open the project file associated with the FAAST LT200 device to be monitored. The Left pane in PipeIQ™ will show
the aspirating system tree (loading the file may take a little while).

Delay Settings
The default values for flow fault delay, general fault delay, prealarm and alarm delay, and remote output alarm time that are preset into the FAAST LT-200 unit are critical for compliance to the
EN54:20 standard.

Click on the FAAST LT-200 Device to highlight it.
Select Connect Device from the Tool menu.
Follow the on-screen instructions to make the connection.
Note: The Send Configuration option in PipeIQ™ enables a saved
configuration to be sent to a FAAST LT-200 device.

Within the Configuration options it is possible to increase delay
times for these actions, but any changes should be made with
extreme caution. Increasing any of these delays should not be
done without a clear understanding of the consequences to the
requirements of the EN54:20 standard.

A user must be connected to the device as an administrator (tick
the Admin box and enter the Administrator password) to access
and perform this command. The Administrator password is the
same as the Remote Maintenance password (the default is 3111)

An increase/decrease in flow above/below the Flow High / Flow
Low limits will result in a Flow Fault after a factory default delay of
60 seconds. Once the flow is returned to a normal level, the fault
condition will be cleared immediately.

The device is connected when a Green Tick is indicated by the
device. A Red Cross indicates that the device is not connected.
Select the Monitoring/Configuration tab as required.

In environments where the sampled airflow may be affected by
sudden temperature/pressure changes due to air handling units,
doors opening/closing etc. or there is a risk of physical interference
with the sampling point, it may be necessary to increase the delay
between the flow going out of limits and signalling a Flow Fault
condition. Delay values of up to 240 seconds before signalling a
fault are available when setting up the detector. This is to allow
time for the air pressures to stabilise after the temporary event.

Monitoring a FAAST LT-200 Device
Once connected to a FAAST LT-200 device, PipeIQ™ can be used
to monitor the device; it is possible to check the status (read device
information), review event logs, activate relays, test the fan speed
and reset the device.
Open a relevant project, highlight the FAAST LT-200 device, Select
Connect Device from the Tools menu and make the connection.
Double click the FAAST LT-200 device to open the large pane on
the right side of the screen. View the device status features by
clicking on the Monitoring tab. An additional tab at the top of the
pane provides access to further features.

Configuring a FAAST LT-200 Device
The PipeIQ™ configuration interface provides a method for viewing
and editing the device configurations. Once connected to a FAAST
LT-200 device, PipeIQ™ can be used to configure the device; it
is possible to set up relay actions, fan speed, critical times and
dates, event log requirements and other operational parameters.
For the Stand Alone versions it is also possible to configure the
alarm thresholds.

Ensuring that the FAAST LT-200 device is highlighted in the left
pane, Select Device information from the Tools menu to view
further info.
For more information on using the Monitoring options, see the
PipeIQ™ Help Menu.

With the Configuration options selected, the General tab displays
in the right pane, with further options available using the Advanced
button (details such as passwords, time-outs and external input
information). If a new project was created, the initial screen display
will show the factory default settings for the device type selected.

IMPORTANT NOTES ON ALTERING FAAST LT-200
SETTINGS
FAAST LT-200 devices are shipped with factory default parameters
that should be adequate for many aspirating applications; a list of
these parameters is shown in Appendix A. If these factory default
parameters are altered, the validity of the new settings must be
confirmed.

Select the Alarms and Relays tab to show details such as relay
latching, alarm mode settings and delays.
Select the Channels and Sensors tab to show details such as fan
speed settings and sensor or channel disablement.

The FAAST LT-200 device is approved to EN54-20 classes A, B
and C (CPR 305/2011). To ensure adherence to this standard,
the class of any pipe/hole configuration and detector
sensitivity must be determined using the design feature of
the PipeIQ™ software (Always check you are using the latest
version of PipeIQ™).
D200-100-01

Note: There are some differences between the graphic screens for
the FAAST LT-200 stand alone and loop based units, owing to the
variation in control and operation between the two.
3

I56-3888-011

For more information on using the Configuration options, see the
PipeIQ™ Help Menu.

or time. Follow the on-screen instructions and then click Update.
Click OK to finish. The clock is immediately reset.

Follow the steps below to configure a FAAST LT-200 device.

Setting the Alarm Level (Stand Alone Versions Only)
The FAAST LT-200 detector uses an internal high-sensitivity
smoke sensor in each channel. This sensor has 9 sensitivity levels
allowing 9 different Alarm or Pre-Alarm settings to be available in
the detector; these are shown in the table following:

1) Open a relevant project, highlight the FAAST LT-200 device,
Select Connect Device from the Tools menu and make the
connection. Double click the FAAST LT-200 device to open
the large pane on the right side of the screen. View the device
settings by clicking on the Configuration tab. At this point, the
screen will show the configuration from the current project
file, NOT the actual device configuration.

Smoke Sensitivity Level

2) Ensuring that the FAAST LT-200 device is highlighted in the
left pane, Select Get Configuration from the Tools menu;
the FAAST LT-200 current configuration parameters will
be uploaded from the device and shown on the PC screen.
Note that this uploaded data from the device will overwrite the
configuration file values in the current project.
3) Set the configuration as required and click Apply, then OK.
4) To save this new device configuration in the current project
select Save from the File menu, or to save as a new project
select Save As from the File menu and enter a new filename.

Obs in %/meter

Note: Only Levels 1 to 5 are available for use in PipeIQ.
To set these levels, ensure the Configuration tab is selected in
the left pane and click the Advanced button in the Channels and
Sensors tab of the right pane. Set the required alarm value from
the drop down menu.

5) To actually change the operating settings in a FAAST
LT-200 device, it is necessary to connect to the unit and
send across the configuration file using the USB link;
see Sending a Configuration to a FAAST LT-200 Device
section.

Using the Day/Night mode, a second set of Alarm and Pre-Alarm
levels can be configured.

Sending a Configuration to a FAAST LT-200 Device
The Send Configuration option in PipeIQ™ will download the saved
configuration settings from a PC to a FAAST LT-200 device. Before
sending the configuration information, ensure that the device is
connected and communicating with the PC.

In the common chamber version of the FAAST LT-200 ( 1 channel
- 2 detectors), it is possible to configure the detector to give alarm
when only 1 sensor (OR) or when both sensors (AND) reach the
alarm level.
FAAST LT-200 Alarm Mode (Loop based version only)
For a FAAST LT-200 device that uses loop communication the
smoke alarm decision is made at the panel.

Select the Configuration tab.
In the left pane, right-click the device and then choose the Send
Configuration option, or choose Send Configuration from the
Tools menu.

Note: When the common chamber version is used (1 channel - 2
detectors) the alarm level for the two detectors must be set at the
same value in the panel.

Enter the Maintenance Password into the dialogue box and click
Download.
A confirmation message appears. Click OK.

The panel can activate an Alarm status at the FAAST LT-200 unit
in one of two ways, pre-settable in the configuration parameters.

Note: When a new configuration is downloaded to a FAAST LT200 device, the new parameters are not used immediately; it is
necessary to exit from the Maintenance mode. Disconnect the PC
and remove the USB cable, close the front cover and then wait
for the Maintenance mode time-out (or press the three front panel
buttons for 2 seconds - see the FAAST LT-200 Quick Installation
Guide) and allow the device to restart.

Sensor Alarm Mode
In this mode, the FAAST LT-200 unit monitors the sensors’ remote
outputs; these are under the control of the panel. When the panel
sets the remote output ON, the related sensor channel will go into
alarm; when the remote output turns OFF, the channel will exit the
alarm state.

Remember that the data uploaded from the FAAST LT-200 device
will overwrite the configuration file in the current project. It is
recommended that a copy of the original configuration is made
and stored before any changes are made to the FAAST LT-200
control parameters (after selecting Get Configuration from the
Tools menu, select Save As from the File menu).

Module Alarm Mode
In this mode the FAAST LT-200 Alarm state is controlled via the
channel module. When the panel sends the output activation ON
command to a channel module, the related channel will go into
alarm. To exit the alarm state the panel must send the output
activation OFF command to the module address.

For more information on using the Configuration options, see the
PipeIQ™ Help Menu.

Note: When the FAAST LT-200 device is set to Sensor Alarm
Mode and an output activation ON command has been sent to
the module address, no alarm LEDs or alarm relay activation will
be performed. Also, when the FAAST LT-200 device is in Module
Alarm Mode the alarm latching options are not allowed.

Time and Date: Setting the Real Time Clock
The time and date clock in the FAAST LT-200 device is set up
independent of the configuration parameters.

Setting the FAAST LT-200 Device Fan speed
Before leaving the factory, an air velocity reference value is set
into each FAAST unit. This equates to an optimum air flow of
approximately 45 l/min. Default high/low flow thresholds are set to
guarantee a flow fault when the air flow is ±20% of the reference
flow. The fan speed in each channel can be set to either Auto
(recommended for normal operation) or Manual control.

With the Monitoring tab selected in the left pane and the FAAST
LT-200 device highlighted, ensure that the Actions tab is selected
in the right pane. The clock configuration section is located in the
bottom left of this pane.
Click Get to refresh the date and time display.
Click on Change FAAST LT-200 Clock to adjust the date and/
D200-100-01

Obs in %/Feet

Level 1*
0,02 % obs/ft
0,07 % obs/m
Level 2
0,03 % obs/ft
0,10 % obs/m
Level 3
0,05 % obs/ft
0,16 % obs/m
Level 4
0,10 % obs/ft
0,33 % obs/m
Level 5
0,20 % obs/ft
0,66 % obs/m
Level 6
0,50 % obs/ft
1,64 % obs/m
Level 7
1,00 % obs/ft
3,28 % obs/m
Level 8
1,50 % obs/ft
4,92 % obs/m
Level 9
2,00 % obs/ft
6,56 % obs/m
* Pre-alarm will be set to 70% of this value if alarm is set to Level 1
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Auto Mode
In automatic fan speed mode, the unit will automatically initialise
to the best fan speed to achieve the configuration reference flow
value at power ON. Auto fan mode is the detector’s default setting.

PipeIQ™ Help
The online help is a guide through the PipeIQ™ application. The
Help opens in a separate window where it is possible to search
and navigate to information on different topics.

Manual Mode
In manual fan speed mode, the unit uses the configured fan speed,
and does not initialise the flow relative to the pre-set reference flow
value. The fan speed can be set to operate in the range between 1
and 10 (highest speed). Manual mode is typically used for set-up
and test purposes only.

Select PipeIQ™ Help from the Help menu or press F1. When you
press F1 the help topic for the active window is invoked.
Using Help - Navigation Pane (Left Pane)
This pane includes Contents, Search and Index tabs. Click on the
tab to access the content of each.
Index: This tab contains a multilevel list of keywords and keyword
phrases. To open a topic in the Display pane (Right pane) associated
with a keyword, double click the keyword. If the keyword is used in
more than one topic, a dialog box is displayed so you can select
the topic to view, and then click Display or double-click the topic.

Fan Speed Test
It is possible to test the fan speed setting using PipeIQ™.
The FAAST LT-200 device must be connected and communicating
with the PC.

Search: This tab helps you to search for a topic or content. Type
the word to search and press Enter on the keyboard. The list of
topics is displayed below. Double click the topic to show it in the
Display pane.

Select the Monitoring tab in the left pane and highlight the FAAST
LT-200 device to be tested; the Actions tab will appear in the right
pane. In the Test Fans Speed box, select the desired fan speed
against the required channel with the slider. Click Test Fan; after
a short period the Flowrate will be displayed. To terminate the test,
click Stop.

Contents: This tab lists the Table of Contents that contains
categorized books and pages. When you double click a closed
book it opens to display its topics, and when you click an open
book it closes. Double click a topic to show it in the Display pane.

FURTHER PIPEIQ™ CAPABILITIES
Creating a Project
To create a project select New from the File menu or click on the
toolbar.

Using Help - Display Pane (Right Pane)
The Display pane on the right of the online help displays the
content for the selected topic.

The New Project dialog box appears.

Blue Underlined Text Indicates a link to a different topic.

In the File Name box, type the name of the project, and then click
Save.

Green Italicized Text Indicates a link to more information or
images in the same topic. Re-click the link to hide the information
or image.

The PipeIQ™ project file is created.
A project can comprise a site, buildings, floors, and devices. When
creating a project, these items are created by default; they must
be defined before designing the pipe layout. For information on
configuring elements on a site, see the PipeIQ™ Help (select
PipeIQ™ Help from the Help menu.
Note: It is possible to add new buildings, floors and devices to
a project after the initial site configuration is complete. Editing or
modifying a project is carried out in the Configuration mode; for
more information on adding elements to a project, refer to the
PipeIQ™ Help Menu.
Designing a Pipe Layout
To create an effective layout, the designer must have knowledge
of the following:
Local codes and standards for the site
Pipe network design
Creating layouts using drawing packages (e.g. AutoCAD® software)
and similar tools producing DXF format files.
For more information on using the Pipe Design Application Tools,
see the PipeIQ™ Help Menu.
Creating Reports
PipeIQ™ can generate the following reports.
Configuration Reports
Event Log Report
Pipe Layout
Bill of Materials.
For more information on using the Report options, see the PipeIQ™
Help Menu.

D200-100-01
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APPENDIX A

FAAST LT-200 CONFIGURATION PARAMETERS AND DEFAULT SET-UP VALUES
A1: FAAST LT-200 CONFIGURATION PARAMETERS
All the FAAST LT-200 configurable parameters are described in
Table A1 below. The default values set into the unit at manufacture
are listed in Tables A2 and A3. The user can change parameter
values using the PipeIQ™ application software that runs on a PC
and then upload the new configuration into the unit.
SA denotes a Stand Alone unit
LB is a Loop Based (addressable) unit
A a denotes applicable
Table A1: FAAST LT-200 Configuration Parameters

#

PARAMETER

1

Maintenance Password

2

3

PARAMETER
RANGE

SA

LB

DESCRIPTION

COMMENTS

1111 - 9999





4 digit code required to enable front panel
push buttons and access Maintenance
mode .
Number used to identify the current device
configuration . Every time the configuration is
changed, this number is incremented .

Factory default password 3111.

Current configuration
number

0 . .255





Factory default is 1 .
When 255 is reached the
number rolls back to 0

DD/MM/YY
HH:MM:SS
YES/NO





4

Current configuration
date
Channel 1 enabled

Date/Time of last device configuration
upload .
YES: Channel is enabled and operating as a
smoke detector .
NO: Channel is disabled .





Only possible with 2 channel
units; cannot disable both
channels at the same time .

5

Channel 2 enabled

YES/NO





6

Sensor 1 enabled

YES/NO





YES: Sensor is enabled and operating as a
smoke detector .
NO: Sensor is disabled

For 1 channel + 2 sensor version
only; not possible to disable both
sensors .

7

Sensor 2 enabled

YES/NO





8

Daylight saving enabled

YES/NO/AUTO





Allows the real time clock date to change for
a daylight saving period (+1 hour)





Start date/time of daylight saving period

NO: Daylight saving off. YES:
period is specified by parameters
9 and 10 .
AUTO: sets start date to last
Sunday in March and end date
to last Sunday in October .
Used when daylight saving is set
to YES.

9

Daylight saving start
date

DD/MM HH:MM

10

Daylight saving end
date

DD/MM HH:MM





End date/time of daylight saving period

11

Disable time

1..240 min





When disabled the device stops reporting
alarms and faults for this period .

When the time expires or
RESET is pressed, device
returns to Normal state .

12

Maintenance timeout

1..30 min or 0 (Not
Used)





Sets the period of inactivity after which a unit
will return to Normal from Maintenance
mode

In remote maintenance (USB
connected) there is no device
timeout .

13

Trend log interval

1..240 min or 0 (Not
Used)





Time interval used by a device to regularly
record its status .

Events are also logged as they
occur .

14

Sensors blinking
replicated

YES/NO





When channel is in alarm, the
alarm LED will change to red .

15

Both supplies monitored

YES/NO





16

Common chamber
sensors required for
alarm

1,2





17

Sounder automatic cutoff time

0 (Not Used),
5,10,15,…,600 s





NO: No blink
YES: Channel alarm LED blinks green when
the detector is in Normal state .
NO: Only power supply #1 input is
monitored .
YES: Power supply #2 is also monitored
Detector alarm logic for common chamber
model (1 channel x2 sensors):
1 . OR function – either sensor in alarm
2 . AND function – both sensors need to be
in alarm .
Sounders turn off after this time period,
following activation .

D200-100-01
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If a sensor is disabled or in fault,
this parameter is ignored .
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#

PARAMETER
RANGE

SA

LB

Channel 1 alarm is
latched
Channel 2 alarm is
latched

YES/NO





YES/NO





20

Alarm delay

0..240 s





21

Auxiliary relay is used
for channel 2 faults

YES/NO





22

Channel 1 label





23

Channel 2 label





24

Channel 1 fan speed
mode
Channel 2 fan speed
mode
Channel 1 manual fan
speed
Channel 2 manual fan
speed
Reference flow for
channel 1

16 character (ASCII
code from decimal
32 to 127)
16 character (ASCII
code from decimal
32 to 127)
Manual, Auto





Manual, Auto





1 . .10





1 . .10





32 – 65 litres/min





Reference flow for
channel 2
High flow threshold for
channel 1
High flow threshold for
channel 2
Low flow threshold for
channel 1

32 – 65 litres/min





Internal Setting





Internal Setting





Internal Setting





33

Low flow threshold for
channel 2

Internal Setting





34

Flow fault delay

0..240 s





A delay can be set to stop reporting a flow
fault for a defined period .

35

Channel 1 filter due date

DD/MM/YY





36

Channel 2 filter due date

DD/MM/YY





Date to clean air filters . When date is
reached, the device will give a filter fault .

37

General fault is latched

YES/NO





38

General fault delay

0..240 s





39

Pressure

68758 – 110000 Pa





40

Power restart alert time

0 (Not Used), 1..240
s,
255 (no time limit)





18
19

25
26
27
28
29
30
31
32

PARAMETER

D200-100-01

DESCRIPTION
NO: When alarm condition is reached, the
device activates the alarm relay . When the
alarm condition is removed the alarm relay is
deactivated .
YES: When alarm condition is reached, the
device activates the alarm relay . When the
alarm condition is removed the alarm relay
remains set until the device is reset .
When alarm condition is reached, a delay
period can be introduced before the alarm is
activated .
NO: Device faults are reported on the fault
relay; this relay is common on 2 channel
units .
YES, the AUX relay will separately report
CH2 faults; CH1 faults continue to be
reported on the fault relay . Common faults
will be reported by both relays .
Provides a label to name a channel in free
text .

Selects the fan speed control mode

Defines the fan speed in manual mode .

This value represents the correct flow level
to maintain .

High flow threshold

Low flow threshold

COMMENTS

If the detector alarm condition is
removed before activation, the
delay is reset .
Faults common to both channel
are, for example, ASD EEPROM
fault, external input fault, etc .

Example: "Building A" "Building
B"

The optimal flow though the
device is about 45 litres/minute.
Typically, this is equivalent to
fan speed 5 .
Low and high flow limits are set
to meet the EN54 requirements.
A flow fault is given if the flow
goes out of the -20% and +20%
of the reference flow range.
In Auto mode, following
initialization, the unit sets the
fan speed to reach the reference
flow programmed in the device.
In Manual mode, the user can
set the fan speed.
Use PipeIQ LT to change default
configuration of the reference
flow (both modes) and fan
speed (manual mode).
If the fault condition is removed
before activation of a fault, the
delay will be reset .

NO: The general fault relay is activated
when a fault is present and will reset when
the fault is removed .
YES: The general fault relay is activated
when a fault is present . When the fault
condition is removed the relay remains set
until a device reset .
A delay can be set to stop reporting a
general fault for a defined period .
If the fault condition is removed before
activation of a fault, the delay will be reset .
Not used .
When the device is switched on, it can give
a power on alert . The time period for this
alert signal can be set by the user .

7
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#

PARAMETER

41

Auxiliary relay set on
low/high temperature
alert
Auxiliary relay set on
external input in not
normal state

PARAMETER
RANGE

SA

LB

YES/NO





YES/NO





Auxiliary relay set on
low power alert / high
power fault
Auxiliary relay set on
flow fault
Auxiliary relay set on
sensor communication
fault
Auxiliary relay set on
power restart alert
Auxiliary relay is
latched

YES/NO





YES/NO





YES/NO





YES/NO





YES/NO





48

External input normal
state

OPEN, SHORT





49

External input triggers
fault

YES/NO





50

External input silences
sounders

YES/NO





51

External input resets
device

YES/NO





52

External input disables
device

YES/NO





53

External input disabling
time

1..1440 min





54

Pre-alarm delay

0 (OFF), 1..240 s



55

Pre-alarm and Alarm
are in cascade

YES, NO



58

Day start time

HH:MI



When the external input is used to disable
the device, this option sets the disable
period .
A delay can be set to stop reporting a prealarm condition for a defined period .
If the pre-alarm condition is removed
before activation of the pre-alarm is
reported, the delay will be reset .
NO: Alarm (or alarm delay) will activate
immediately on alarm condition .
YES: Alarm condition does not activate
until pre-alarm condition (and related
delay) has completed .
Start of daytime mode operation

59

Day end time

HH:MI



End of daytime mode operation

60

Holiday day #1 date

DD/MM



On these days, the device uses the night
time settings only (every year) .

Holidays #2…#19

DD/MM



00/00 = not used
Day/Night mode (Parameter 81)
must be set to YES.

79

Holiday day #20 date

DD/MM



80

Sounder activation
mode

On Pre-alarm, On
Alarm



This option defines which event will
activate the sounder relay .

If “On Pre-Alarm” is selected,
sounders remain active in alarm .

81

Day/night mode
enabled

YES/NO



Allows use of two different sets of alarm
and pre-alarm levels .
NO: Day settings are always used
YES: Device will change between day and
night settings at selected times .

42

43
44
45
46
47

D200-100-01

DESCRIPTION
User chooses the event(s) that will
activate the auxiliary relay .
NO: not used
YES: activates the AUX relay

NO: The AUX relay is activated when a
chosen event is present and will reset
when the event trigger is removed .
YES: The general AUX relay is activated
when a chosen event is present . When
the event trigger is removed the relay
remains set until a device reset .
No action is triggered by the input in this
state .
OPEN: requires closed contacts to cause
an input response .
SHORT: requires an open circuit to cause
an input response .
User chooses the activity that is triggered
by the external input .
NO: not used
YES: activated by external input.
Note that only one action can be selected
at a time .

8

COMMENTS
It is possible to have more than one
event set the Aux relay . If any one
of the chosen events occurs, the
Aux relay will be activated (they are
combined as an OR function) .

Note: External input only active in
NORMAL state .

Minimum daytime period = 1 hour .

I56-3888-011

#

PARAMETER

PARAMETER
RANGE

SA

82

Monday is holiday

YES/NO



83

Tuesday is holiday

YES/NO



84

Wednesday is holiday

YES/NO



85

Thursday is holiday

YES/NO



86

Friday is holiday

YES/NO



87

Saturday is holiday

YES/NO



88

Sunday is holiday

YES/NO



89

Sensor 1 day alarm
level
Sensor 2 day alarm
level
Sensor 1 day pre-alarm
level
Sensor 2 day pre-alarm
level
Sensor 1 night alarm
level
Sensor 2 night alarm
level
Sensor 1 night prealarm level
Sensor 2 night prealarm level
Alarm mode

1..9



1..9



1..9



1..9



1..9



1..9



1..9



1..9



90
91
92
93
94
95
96
97

Sensor Mode,
Module Mode

LB

DESCRIPTION



Day and night pre-alarm and alarm level
settings.
Only Levels 1 to 5 are available for prealarm and alarm use when using
PipeIQ.(must use version 2.9.1 or higher).

Pre-alarm will be set to 70% of
alarm level if alarm is set to Level
1.

Sets the method used to indicate an
alarm.

Note that the Output Activate
command will not set an alarm in
Sensor Mode, and turning on the
sensor remote output will not set an
alarm in Module Mode.

SENSOR MODE: When remote output on
a sensor is set ON for configured time,
that sensor channel goes into alarm.
When the remote output turns OFF, the
channel stops signalling alarm.

98

Sensor communication
timeout

0 (Not Used),
1…240 s



99

Remote output time for
alarm

50, 100,...10000ms



D200-100-01

COMMENTS

Allows use of different alarm and prealarm levels on one or more days of the
week
NO: Device will change between day and
night settings at selected times (if
Parameter 81 set).
YES: Night settings are always used

MODULE MODE: When the Output
Activate command is sent to a channel
module, that channel goes into alarm. To
exit alarm, an Output Deactivate
command must be sent.
The device will give a sensor
communication fault when a sensor is
inactive for this period of time.
The device will go to alarm if the sensor
remote output is ON at least for this time.

9

Note that when in Module Mode, an
alarm is not latched.
In common chamber (2 sensor)
version – the Sensor Mode is
required to enable the AND/OR
option.
Inactive means that sensor remote
output is OFF and it is not blinking.
Not applicable when Alarm Mode is
set to Module Mode.
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A2: FAAST LT-200 DEFAULT SET-UP VALUES
All the default value settings are listed in the following two tables.
Table A2 refers to Stand Alone units, whilst Table A3 refers to Loop
Based (addressable) units.
X means that a parameter is Not Applicable.
* value set to Italian time zone at manufacture.
Table A2: Stand Alone Versions

#

PARAMETER

PARAMETER RANGE

1 Channel
1 Sensor

1 Channel
2 Sensor

2 Channel
2 Sensor

1
2
3

Maintenance Password
Current configuration number
Current configuration date

1111 - 9999
0..255
DD/MM/YY HH:MM:SS

3111
1
*

3111
1
*

3111
1
*

4
5
6
7
8

Channel 1 enabled
Channel 2 enabled
Sensor 1 enabled
Sensor 2 enabled
Daylight saving enabled

YES/NO
YES/NO
YES/NO
YES/NO
YES/NO/AUTO

YES
X
YES
X
NO

YES
X
YES
YES
NO

YES
YES
YES
YES
NO

9
10

Daylight saving start date
Daylight saving end date

DD/MM HH:MM
DD/MM HH:MM

25/02 02:00
28/10 02:00

25/02 02:00
28/10 02:00

25/02 02:00
28/10 02:00

11
12

Disable time
Maintenance timeout

1..240 min
1..30 min or 0 (DISABLED)

60
5

60
5

60
5

13

Trend log interval

1..240 min or 0 (DISABLED)

0

0

0

14

Sensors blinking replicated

YES/NO

YES

YES

YES

15
16

YES/NO
1,2

NO
1

NO
1

NO
1

17
18

Both supplies monitored
Number of sensors required in
alarm
Sounder automatic cut-off time
Channel 1 alarm is latched

0 (Disabled), 5,10,15,…,600 s
YES/NO

0
YES

0
YES

0
YES

19

Channel 2 alarm is latched

YES/NO

YES

YES

YES

20

Alarm delay

0 ..240 s

0

0

0

21

Auxiliary relay is used for channel 2
faults
Channel 1 label
Channel 2 label
Channel 1 fan speed mode
Channel 2 fan speed mode
Channel 1 manual fan speed
Channel 2 manual fan speed
Reference flow for channel 1
Reference flow for channel 2
High flow threshold for channel 1
High flow threshold for channel 2
Low flow threshold for channel 1
Low flow threshold for channel 2
Flow fault delay
Channel 1 filter due date
Channel 2 filter due date
General fault is latched
General fault delay
Pressure
Power restart alert time

YES/NO

YES

YES

YES

16 char (ASCII code from 32 to 127)
16 char (ASCII code from 32 to 127)
Manual, Auto
Manual, Auto
0..10
0..10
32 – 65 litres/min
32 – 65 litres/min
-50% to +50%
-50% to +50%
-50% to +50%
-50% to +50%
0..240 s
DD/MM/YY
DD/MM/YY
YES/NO
0..240 s
68758 – 110000 Pa
0 (Alert disabled), 1..240 s,
255 (no time limit)
YES/NO

“1”
“1”
“1”
X
X
“2”
Auto
Auto
Auto
X
X
Auto
X
X
X
X
X
X
45 litres/min
45 litres/min
45 litres/min
X
X
45 litres/min
set to EN54-20 requirements (-20% - +20%)
X
X
As Above
set to EN54-20 requirements (-20% - +20%)
X
X
As Above
60
60
60
01/01/99
01/01/99
01/01/99
X
X
01/01/99
NO
NO
NO
60
60
60
101325
101325
101325
0
0
0
NO

NO

NO

YES/NO

NO

NO

NO

YES/NO

NO

NO

NO

22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43

Auxiliary relay set on low/high
temperature alert
Auxiliary relay set on external input
in not normal state
Auxiliary relay set on low power
alert / high power fault

D200-100-01
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1 Channel
2 Sensor

2 Channel
2 Sensor

PARAMETER

44
45

Auxiliary relay set on flow fault
Auxiliary relay set on sensor
communication fault
Auxiliary relay set on power restart
alert
Auxiliary relay is latched
External input normal state
External input triggers fault
External input silences sounders
External input reset device
External input disables ASD
External input ASD disabling time
Pre-alarm delay

YES/NO
YES/NO

NO
NO

NO
NO

NO
NO

YES/NO

NO

NO

NO

YES/NO
OPEN, SHORT
YES/NO
YES/NO
YES/NO
YES/NO
1..1440 min
0 (OFF), 1..240 s

NO
OPEN
NO
NO
YES
NO
60
0

NO
OPEN
NO
NO
YES
NO
60
0

NO
OPEN
NO
NO
YES
NO
60
0

YES, NO

NO

NO

NO

58

Pre-alarm and Alarm are in
cascade
Day start time

HH:MI

08:00

08:00

08:00

59

Day end time

HH:MI

17:00

17:00

17:00

60
79
80

Holiday day #1 date
…
Holiday day #20 date
Sounder activation mode

DD/MM
DD/MM
DD/MM
On Pre-alarm, On Alarm

empty
empty
empty
Alarm

empty
empty
empty
Alarm

empty
empty
empty
Alarm

81
82

Day/night mode enabled
Monday is holiday

YES/NO
YES/NO

NO
NO

NO
NO

NO
NO

83
84
85

Tuesday is holiday
Wednesday is holiday
Thursday is holiday

YES/NO
YES/NO
YES/NO

NO
NO
NO

NO
NO
NO

NO
NO
NO

86
87

Friday is holiday
Saturday is holiday

YES/NO
YES/NO

NO
NO

NO
NO

NO
NO

88
89
90

Sunday is holiday
Sensor 1 day alarm level
Sensor 2 day alarm level

YES/NO
1..9
1..9

NO
1*
1*

NO
1*
1*

NO
1*
1*

91

Sensor 1 day pre-alarm level

1..9

1*

1*

1*

92

Sensor 2 day pre-alarm level

1..9

1*

1*

1*

93

Sensor 1 night alarm level

1..9

1*

1*

1*

94

Sensor 2 night alarm level

1..9

1*

1*

1*

95

Sensor 1 night pre-alarm level

1..9

1*

1*

1*

96

Sensor 2 night pre-alarm level

1..9

1*

1*

1*

97

Alarm mode

X

X

X

X
X

X
X

X
X

46
47
48
49
50
51
52
53
54
55

PARAMETER RANGE

1 Channel
1 Sensor

#

Sensor alarm mode, module alarm
mode
98 Sensor communication timeout
0 (Disabled),1…240 s
99 Remote output time for alarm
50, 100,...10000ms
* Pre-alarm will be set to 70% of this Level 1 value.

D200-100-01
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Table A3: Loop Based (Addressable) Versions

#

PARAMETER

PARAMETER RANGE

1 Channel
1 Sensor

1 Channel
2 Sensor

2 Channel
2 Sensor

1
2
3

Maintenance Password
Current configuration number
Current configuration date

1111 - 9999
0..255
DD/MM/YY HH:MM:SS

3111
1
*

3111
1
*

3111
1
*

4
5
6
7
8

Channel 1 enabled
Channel 2 enabled
Sensor 1 enabled
Sensor 2 enabled
Daylight saving enabled

YES/NO
YES/NO
YES/NO
YES/NO
YES/NO/AUTO

YES
X
YES
X
NO

YES
X
YES
YES
NO

YES
YES
YES
YES
NO

9
10

Daylight saving start date
Daylight saving end date

DD/MM HH:MM
DD/MM HH:MM

25/02 02:00
28/10 02:00

25/02 02:00
28/10 02:00

25/02 02:00
28/10 02:00

11
12

Disable time
Maintenance timeout

1..240 min
1..30 min or 0 (DISABLED)

60
5

60
5

60
5

13

Trend log interval

1..240 min or 0 (DISABLED)

0

0

0

14

Sensors blinking replicated

YES/NO

YES

YES

YES

15
16

YES/NO
1,2

NO
1

NO
1

NO
1

17
18

Both supplies monitored
Common chamber sensors
required for alarm
Sounder automatic cut-off time
Channel 1 alarm is latched

0 (Disabled), 5,10,15,…,600 s
YES/NO

0
NO

0
NO

0
NO

19

Channel 2 alarm is latched

YES/NO

NO

NO

NO

20

Alarm delay

0 ..240 s

0

0

0

21

Auxiliary relay is used for channel 2
faults
Channel 1 label
Channel 2 label
Channel 1 fan speed mode
Channel 2 fan speed mode
Channel 1 manual fan speed
Channel 2 manual fan speed
Reference flow for channel 1
Reference flow for channel 2
High flow threshold for channel 1
High flow threshold for channel 2
Low flow threshold for channel 1
Low flow threshold for channel 2
Flow fault delay
Channel 1 filter due date
Channel 2 filter due date
General fault is latched
General fault delay
Pressure
Power restart alert time

YES/NO

YES

YES

YES

16 char (ascii code from 32 to 127)
16 char (ascii code from 32 to 127)
Manual, Auto
Manual, Auto
0..10
0..10
32 – 65 litres/min
32 – 65 litres/min
-50% to +50%
-50% to +50%
-50% to +50%
-50% to +50%
0..240 s
DD/MM/YY
DD/MM/YY
YES/NO
0..240 s
68758 – 110000 Pa
0 (Alert disabled), 1..240 s, 255 (no
time limit)
YES/NO

“1”
“1”
“1”
X
X
“2”
Auto
Auto
Auto
X
X
Auto
X
X
X
X
X
X
45 litres/min
45 litres/min
45 litres/min
X
X
45 litres/min
set to EN54-20 requirements (-20% - +20%)
X
X
As Above
set to EN54-20 requirements (-20% - +20%)
X
X
As Above
60
60
60
01/01/99
01/01/99
01/01/99
X
X
01/01/99
NO
NO
NO
0
0
0
101325
101325
101325
0
0
0
NO

NO

NO

YES/NO

NO

NO

NO

YES/NO

NO

NO

NO

YES/NO
YES/NO

NO
NO

NO
NO

NO
NO

YES/NO

NO

NO

NO

YES/NO

NO

NO

NO

22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47

Auxiliary relay set on low/high
temperature alert
Auxiliary relay set on external input
in not normal state
Auxiliary relay set on low power
alert / high power fault
Auxiliary relay set on flow fault
Auxiliary relay set on sensor
communication fault
Auxiliary relay set on power restart
alert
Auxiliary relay is latched

D200-100-01
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#

PARAMETER

PARAMETER RANGE

1 Channel
1 Sensor

1 Channel
2 Sensor

2 Channel
2 Sensor

48
49
50
51
52
53
54

External input normal state
External input triggers fault
External input silences sounders
External input reset device
External input disables ASD
External input ASD disabling time
Pre-alarm delay

OPEN, SHORT
YES/NO
YES/NO
YES/NO
YES/NO
1..1440 min
0 (OFF), 1..240 s

OPEN
NO
NO
YES
NO
60
X

OPEN
NO
NO
YES
NO
60
X

OPEN
NO
NO
YES
NO
60
X

55

YES, NO

X

X

X

58

Pre-alarm and Alarm are in
cascade
Day start time

HH:MI

X

X

X

59

Day end time

HH:MI

X

X

X

60

Holiday day #1 date

DD/MM

X

X

X

…

DD/MM

X

X

X

79

Holiday day #20 date

DD/MM

X

X

X

80

Sounder activation mode

On Pre-alarm, On Alarm

X

X

X

81

Day/night mode enabled

YES/NO

X

X

X

82

Monday is holiday

YES/NO

X

X

X

83

Tuesday is holiday

YES/NO

X

X

X

84

Wednesday is holiday

YES/NO

X

X

X

85

Thursday is holiday

YES/NO

X

X

X

86

Friday is holiday

YES/NO

X

X

X

87

Saturday is holiday

YES/NO

X

X

X

88

Sunday is holiday

YES/NO

X

X

X

89

Sensor 1 day alarm level

1 . .9

X

X

X

90

Sensor 2 day alarm level

1 . .9

X

X

X

91

Sensor 1 day pre-alarm level

1 . .9

X

X

X

92

Sensor 2 day pre-alarm level

1 . .9

X

X

X

93

Sensor 1 night alarm level

1..9

X

X

X

94

Sensor 2 night alarm level

1..9

X

X

X

95

Sensor 1 night pre-alarm level

1 . .9

X

X

X

96

Sensor 2 night pre-alarm level

1 . .9

X

X

X

97

Alarm mode

Sensor

Sensor

Sensor

98

Sensor communication timeout

Sensor alarm mode, module alarm
mode
0 (Disabled),1…240 s

0

0

0

99

Remote output time for alarm

50, 100,...10000ms

3000

3000

3000

D200-100-01
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APPENDIX B

FAAST LT-200 FAULT CODES
Below is the list of fault codes that can be generated by the FAAST
LT-200 unit. They will be displayed in the Event Log (up to 2244
events can be recorded before being overwritten).
FAULT /
ALERT

Fault [F001]

DESCRIPTION
Device configuration data
is not available .

Fault [F002]

EEPROM FAULT

Fault [F004]

EXTERNAL INPUT
FAULT

Device is unable to access
its EEPROM .
Device external line input
fault .

Fault [F005]

ULTRASONIC
CIRCUIT FAULT
CH1
SOUNDER FAULT
CH1

Fault [F007]

Fault [F008]

Fault [F006]

Fault [F010]
Fault [F011]
Fault [F012]
Fault [F013]
Fault [F014]
Fault [F015]

LB is a Loop Based (addressable) unit
Note: An X denotes Applicable to either SA, LB or both.
SA

LB

X

X

NOTES
This fault is given when at power-on EEPROM data is
not available (device cannot read its EEPROM) or
when data is wrong (bad checksum) or when data is
invalid (not in correct range) . When device is in
WRONG CONFIGURATION fault it enters
automatically into maintenance mode, waits for USB
connection and activates only general fault relay .
Note that in WRONG CONFIGURATION, if RESET is
pressed for 2 seconds, device will restart . Normal key
functions are not available .

X

X

X

X

The ultrasonic circuit of
channel 1 is not working
properly .
The sounder 1 output is in
short or open circuit .

X

X

X

X

Please check the sounder circuit and the 47K end of
line resistor .

SENSOR
COMMUNICATION
FAULT S1

Error in communication
with sensor 1 .

X

X

SENSOR
INITIALIZATION
FAULT S1
FAN FAULT CH1

Error in initialization of
sensor 1 .

X

In SA variant, it is given when sensor doesn’t answer
to FAAST LT unit or sensor reports low chamber
signal .
In LB, sensor alarm mode, it is given when sensor
remote output is OFF for configured timeout .

Problem with channel 1
fan
Channel 1 flow
initialization failed .

X

X

Fan is broken or has stopped

X

X

Impossible to set a fan speed to have the correct flow

Channel 1 flow is below
the configured limit .
Channel 1 flow is over the
configured limit .
The ultrasonic circuit of
channel 2 is not working
properly .
The sounder 2 output is in
short or open circuit .

X

X

X

X

X

X

User can configure a specific delay between fault
condition and fault indication (0-240 s)
User can configure a specific delay between fault
condition and fault indication (0-240 s)

X

X

Please check the sounder circuit and the 47K end of
line resistor .

X

In SA variant, it is given when sensor doesn’t answer
to FAAST LT unit or sensor reports low chamber
signal .
In LB, sensor alarm mode, it is given when sensor
remote output is OFF for configured timeout .

FLOW
INITIALIZATION
FAULT CH1
LOW FLOW FAULT
CH1
HIGH FLOW FAULT
CH1
ULTRASONIC
CIRCUIT FAULT
CH2
SOUNDER FAULT
CH2

Given when external input is configured to give fault
when not in normal state

Fault [F016]

SENSOR
COMMUNICATION
FAULT S2

Error in communication
with sensor 2 .

X

Fault [F017]

SENSOR
INITIALIZATION
FAULT S2
FAN FAULT CH2

Error in initialization of
sensor 2 .

X

Problem with channel 2
fan .
Channel 2 flow
initialization failed .

X

X

Fan is broken or has stopped

X

X

Impossible to set a fan speed to have the correct flow

Channel 2 flow is below
the configured limit .
Channel 2 flow is over the
configured limit .
Device supply voltage is
over 32.5 V (nominal).
FAAST LT unit stopped .
Device loop based data is
not available .

X

X

X

X

X

X

User can configure a specific delay between fault
condition and fault indication (0-240 s)
User can configure a specific delay between fault
condition and fault indication (0-240 s)
Check the voltage .

Device is unable to read or
set its real time clock .
The date stored in device
real time clock is not valid .
Device temperature is
over the limit .

X

X

Logs are written without date .

X

X

X

X

Logs are written without date . Please update date .
RTC keeps the time with power off for about 30 years.

Fault [F019]
Fault [F020]
Fault [F021]
Fault [F022]
Fault [F023]
Alert [A001]
Alert [A002]
Alert [A003]
Alert [A004]

D200-100-01

SHORT NAME
CONFIGURATION
FAULT

SA denotes a Stand Alone unit

FLOW
INITIALIZATION
FAULT CH2
LOW FLOW FAULT
CH2
HIGH FLOW FAULT
CH2
HIGH POWER
FAULT
LOOP BASED
CONFIGURATION
FAULT
REAL TIME CLOCK
ALERT
INVALID TIME
BASE ALERT
HIGH
TEMPERATURE
ALERT

X
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FAULT /
ALERT

SA

LB

LOW
TEMPERATURE
ALERT
LOW POWER
ALERT

Device temperature is
under the limit.

X

X

Device supply voltage is
under 21 V (nominal).

X

X

Alert [A007]

POWER RESTART
ALERT

Device was not powered
for an unknown period of
time.

X

X

Alert [A008]

COMPENSATION
50% DIRTY ALERT
S1

The sensor 1 chamber is
dirty. The sensor software
has reached 50% of
possible compensation.

X

Check the voltage. Changing the FAAST LT unit
parameter, it is possible to monitor either the main or
both power supplies
Given after every POWER ON.
This alert can be disabled, given only for a defined
time or it can be latched depending on the
configuration.
In SA version, alert time has to be longer than the time
for sensors to become stable (45 s).
Please clean the sensor.

Alert [A009]

COMPENSATION
75% DIRTY ALERT
S1

X

Please clean the sensor.

Alert [A010]

DRIFT LIMIT ALERT
S1

X

Please clean the sensor.

Alert [A011]

FILTER ALERT CH1

The sensor 1 chamber is
very dirty. The sensor
software has reached 75%
of possible compensation.
The sensor 1 chamber is
very dirty and has reached
the maximum level of
compensation possible.
Filter 1 due date reached.

Alert [A012]

COMPENSATION
50% DIRTY ALERT
S2

The sensor 2 chamber is
dirty. The sensor software
has reached 50% of
possible compensation.

X

Please clean the sensor.

Alert [A013]

COMPENSATION
75% DIRTY ALERT

X

Please clean the sensor.

Alert [A014]

DRIFT LIMIT ALERT
S2

X

Please clean the sensor.

Alert [A015]

FILTER ALERT CH2

The sensor 2 chamber is
very dirty. The sensor
software has reached 75%
of possible compensation.
The sensor 2 chamber is
very dirty and has reached
the maximum level of
compensation possible.
Filter 2 due date reached.

Alert [A016]

LED PCB ERROR

Alert [A005]
Alert [A006]

D200-100-01

SHORT NAME

DESCRIPTION

Bad communication with
LED pcb.

X

X

X

X

X

X

15

NOTES

Please check connection.
Note: when unit has PCB error, user can enter
MAINTENANCE mode, opening front cover (no
password is needed)
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5

FAN
SPEED
= 10

FAN
SPEED
= 10

3

5.2

10

Hole 1

2
2

1
2

2

3
2

4

Hole 2

6

7

Hole 2

HOLE
1
2
SIZE (mm) 3.5 3.5

13

8

9

10

4
4

3
4

13

5

5

Hole 3

3

12
3

13

15

16

3.5 3.5 3.5

14
4

4

17 END

Hole 17

5

END

13

75m

Hole 4

13
Hole 5

Flow: - 40 l/min, Balance = 0.73, Alarm level 1

3

11

Hole 16

5.4

1 Channel Single Pipe
80m - Class B

2.5 2.5 2.5 2.5 2.5 2.5

5

97m

Flow = 41 l/min, Balance = 0.65, Alarm Level = 1

1 Channel Single Pipe
100m x 18 Holes - Class C

Example Pipe Configuration

HOLE
SIZE (mm)

Hole 1

5.4

Example Pipe Configuration

13

5.4

End hole
(Hole 6)

End Hole
(Hole 18)

EXAMPLE PIPE CONFIGURATIONS - 1 CHANNEL (can be duplicated for 2 channel units)

APPENDIX C
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Hole 1

HOLE
SIZE (mm)

2
6

1
5

25

6.5

END

Hole 2

25

17

End Hole
(Hole 18)

9

9

9

9
9

76m

9
9

9

9

9

Hole 5

Hole 4

Hole 3

Hole 2

Hole 10

6
15
2.5 2.5

5
14

9

9
9

3

8 END
17 END
2.5 2.5

7
16

Hole 6

1
2
3
4
HOLE
10 11 12 13
HOLE
SIZE (mm) 2.5 2.5 2.5 2.5

9

76m

1 Channel T-Piece (2 Pipes)
80m - Class C

Flow = 57 l/min
Balance = 0.7
Alarm level = 1

Hole 7

FAN
SPEED
= 10

4

4

4
9

≤ 80m

Typical Example Pipe Configuration

≤ 80m

≤ 160m

End hole
(Hole 3)

Flow = 38 l/min, Balance = 0.94, Alarm level = 1

1 Channel Single Pipe
80m - Class A

EXAMPLE PIPE CONFIGURATIONS - MAXIMUM 1 CHANNEL WITH BRANCH: 2 X 80m = 160m CLASS C

FAN
SPEED
= 10

5

25

75m

Example Pipe Configuration

Hole 8

Hole 1

Hole 11

Hole 12

Hole 13

Hole 14

Hole 15

Hole 16

Hole 17

I56-3888-011

9
End Hole
(Hole 9)

EXAMPLE PIPE CONFIGURATIONS USING EXTERNAL FILTER

Example Pipe Configuration

1 Channel Single Pipe
With Filter - Class C

Flow = 43 l/min, Balance = 0.72, Alarm level 1

47m
6

5

3

Hole 1

6

6
Hole 3

Hole 2

6

6
Hole 5

Hole 4

6

6
Hole 6

End hole
(Hole 8)

Hole 7

FILTER

FAN
SPEED
=9

6
7 END
HOLE
1
2
3
4
5
SIZE (mm) 3.5 3.5 3.5 3.5 3.5 3.5 3.5 3.5

Example Pipe Configuration

1 Channel Single Pipe
With Filter - Class B

Flow = 44 l/min, Balance = 0.7, Alarm level 1

47m
7

12

3

Hole 1

FILTER

FAN
SPEED
=9

HOLE
SIZE (mm)

1
4

7

7
Hole 3

Hole 2

2

3

4.5 4.5

4

5

END

5

5.5

6.5

Example Pipe Configuration

7

7
Hole 4

Hole 5

End hole
(Hole 6)

1 Channel Single Pipe
With Filter - Class A

Flow = 36 l/min, Balance = 0.91, Alarm level 1

47m
34

3

FAN
SPEED
= 10

D200-100-01

13
Hole 1

FILTER

End hole
(Hole 2)

HOLE
1 END
SIZE (mm) 6.5 6.5
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APPENDIX D

ACCESSING. INSTALLING AND RUNNING THE LATEST VERSION OF PipeIQ™
TO DOWNLOAD PipeIQ™

6) Select the aspirating unit to be used and click OK:

The latest version of System Sensor pipe design software PipeIQ
can be found at:
www.systemsensoreurope.com
Save the file to the PC’s Downloads folder.
TO INSTALL PipeIQ™
1) Open the PC’s Downloads folder and unzip the PipeIQ-200x
file.

7) It is now possible to design an aspirating pipe network, or
configure and monitor an aspirating device. A Help button is
available in the Toolbar to assist with understanding the range
of operations and options that are available.

2) Find the file PipeIQ Setup exe and run it.
3) Follow the Install Wizard on-screen instructions through to Finish:
Any earlier version of PipeIQ that has been installed on the PC will
be upgraded to the latest version.
TO RUN PipeIQ™
The install wizard will put a PipeIQ icon on the
PC desktop when the PipeIQ setup is run.
1) Click on this icon (or find the location of the installed PipeIQ exe
file and Run it). The PipeIQ configuration screen will appear.
2) Select a new project or open an existing one:

3) For a new project, choose a file name and Save it.
4) Read and acknowledge the disclaimer and click OK:

5) Select the required measurement units and click OK:

D200-100-01
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APPENDIX E

PipeIQ™ AND PIPE SYSTEM DESIGN
PIPE DESIGN METHODOLOGY
FLOW
CHART Methodology Flow Chart
Pipe
Design
PipeIQ is a design application to help a user create EN54 compliant
pipe layouts. Generating a suitable working design will require
some thought and understanding of the interacting variables in an
Start Project
and create
aspirating system.
pipe layout

The following methodology can assist when trying to design a
pipe network using PipeIQ. By following this sequence of steps,
it should be possible to arrive at an acceptable design (assuming
one exists) that has adequate air flow and hole sensitivity to
operate within the overall limits of the aspirating device. (See Pipe
Design Methodology Flow Chart.)

Set number of
holes and hole
spacing

Review pipe
layout

Suggested Design Methodology
1. Start a project in PipeIQ, choose the detector type, select the
required constraints option and the aspirating class and follow
the instructions to add a detector and create a representation
of the physical pipe layout. To optimise the design:

N
Is a design
possible?

2. In the Manage Pipe – Edit Properties window, set the number
of sample holes and hole spacing in the pipe network to comply
with local fire regulations and the EN54 approved figures. The
hole diameters can also be set in this window, or changed later.
To end, click Update Holes and then OK.

Y

Set sample hole
diameters and fan
speed

Are the
parameters in
range?

3. In the Design tab, click on the Calculations button; the
Calculation window will appear. Set the sample hole diameters
and fan speed to get the flow in the detector close to 45l/min.

N

Y

4. Repeat step (3) above to eliminate any red boxes (out-of-range
sensitivity, transport time etc.)

N

Is air flow
c.45l/min?

5. Check the flow balance is ≥0.5. Using the auto-balance button
will probably create multiple sample hole diameters along the
pipe; avoid using this button if a single hole size is required. Be
aware that the auto-balance function may also reduce the
pipe air flow, ensure this is set back close to 45l/min.

Y

N

Is the flow
balance ≥ 0.5?

6. Repeat from step (3), adjust hole diameters and fan speed to
achieve all the above figures.

Y

7. Next, check that the sample hole sensitivity is practical for the
chosen class, i.e. it is not too sensitive. Ideally, to avoid false
alarms, hole sensitivity for a class C system should be 1%/m or
greater and certainly >0.5%/m.

??

8. If necessary, change the Alarm level to reduce the sample hole
sensitivity. The detector sensitivity is set from the Configuration
tab.

Is hole
sensitivity OK
for class?

N

Change alarm
level

Y

9. Repeat from step (3) to finalise the pipe design and save.
Tips to achieve an adequate design
Maintain the air flow in a FAAST LT unit at, or around, its optimum
setting of 45 l/min. Increase/decrease hole diameters and fan
speed to achieve this.

Save design

at the optimal level, since it is equivalent to increasing the pipe
diameter to the aspirating device; but beware the flow does not
get too high. In twin pipe systems it may be necessary to reduce
hole sizes, compared with a single pipe, to achieve optimal flow.
Alternatively, the fan speed can also be reduced, but both these
actions will increase the transport time.

Fewer holes in a pipe will tend to increase the sample hole
sensitivity. Adding extra holes close together may mathematically
appear to reduce the hole sensitivity, but in practical terms the
system sensitivity will remain high. Change the alarm level to raise
or lower the sensitivity of the sample holes.
Changing the hole diameter will affect the hole sensitivity and the
hole balance. Smaller holes may improve the balance but will
reduce the overall flow. Ensure this remains as close to 45l/min as
possible. It is recommended that the flow balance is not less than
0.5 for an acceptable design.

Use of the Auto-balance button in PipeIQ will probably give the
holes in the pipe design a variety of different diameters. If one
size of hole in the sample pipe is desirable (for simpler installation
and commissioning) do not use this button. Pipes with equal size
sample holes are also easier to test – the farthest end sample hole
will be the least sensitive.

Longer pipes will obviously have longer transport times; they also
tend to reduce the air flow, which further extends the transport
time. Rather than using one long single pipe, the use of a ‘T’ tap
or two pipes per channel can reduce long pipe runs and reduce
the transport time. It also helps with maintaining the air flow speed

Note that the fan speed setting is required to calculate the reference
air flow in PipeIQ. However, a FAAST LT device will automatically
set the correct air flow at commissioning time, when used in the
normal auto fan mode (set as default). It is not necessary to set
the fan manually.

D200-100-01
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System Sensor Europe
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